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Disclaimer and Risk Warnings

Trading any financial market involves risk. The content of this e-book, its various 
associated websites and all related correspondence are neither a solicitation nor 
an offer to purchase or sell any financial instrument.

Although every attempt has been made to assure accuracy, we do not give any 
express or implied warranty as to its accuracy. We do not accept any liability for 
error or omission. Examples are provided for illustrative and educational 
purposes only and should not be construed as investment advice or strategy.

No representation is being made that any account or trader will or is likely to 
achieve profits or losses similar to those discussed in this e-book. Past 
performance is not indicative of future results.

By purchasing the software, subscribing to our mailing list or using the website 
you will be deemed to have accepted these terms in full.

The Forex-NoNameBot.com publishers, their representatives and associates do 
not and cannot give investment advice.

We endeavor to insure that related websites are available 24 hours per day but 
we cannot be held liable if, for any reason, a site is unavailable. The information 
provided in this e-book is not intended for distribution to, or for use by, any 
person or entity in any jurisdiction or country where such distribution or use 
would be contrary to law or regulation or which would subject us to any 
registration requirement within such jurisdiction or country.

Hypothetical performance results have many inherent limitations, some of which 
are mentioned below. No representation is being made that any account will or is 
likely to achieve profits or losses similar to those shown. In fact, there are 
frequently sharp differences between hypothetical performance results and 
actual results subsequently achieved by any particular trading program.

One of the limitations of hypothetical performance results is that they are 
generally prepared with the benefit of hindsight. In addition, hypothetical trading 
does not involve financial risk and no hypothetical trading record can completely 
account for the impact of financial risk in actual trading.

For example: the ability to withstand losses or to adhere to a particular trading 
program in spite of trading losses are material points which can also adversely 
affect trading results. There are numerous other factors related to the market in 
general and to the implementation of any specific trading program, which cannot 
be fully accounted for in the preparation of hypothetical performance results, all 
of which can adversely affect actual trading results.
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We reserve the right to change these terms and conditions without notice. You 
can check for updates to this disclaimer at any time without notification.
The content of this e-book and all related websites and correspondence are 
copyright and may not be copied or reproduced.

U.S. Government Required Disclaimer

Commodity Futures Trading Commission Futures and Options trading have large 
potential rewards, but also large potential risk. You must be aware of the risks 
and be willing to accept them in order to invest in the FOREX, futures and 
options markets. The past performance of any trading system or methodology is 
not necessarily indicative of future results.
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Introduction
Congratulations - the NoNameBot.com is the highest quality automated trading robot 
you can obtain!

This robot trading software (also known as an "Expert Advisor" or "EA" for short) will 
analyze and trade the Forex market for you, 100% automatically. It is quick and easy to 
install, as you'll see in a minute. 

These are some of the advantages of NoNameBot:

• 100% automatic hands-free trading. 
• Watches the markets for you 24 hours each and every day. 
• Complimentary upgrade version for the new MetaTrader 5 platform.
• Profitable trading without any hassles or emotional issues.
• Eliminates destructive emotions of greed and fear. 
• Easy to use: quickly install and trade.
• One Time Payment - Updates included - No monthly fee.
• Built in unique and sophisticated Money Management.
• Works on any account type, standard and mini accounts.

Important!

1. Please read this manual thoroughly before attempting to 
operate The NoNameBot!

2. The NoNameBot is best suited for brokers who offer a low 
spread on the currency pair EURCHF. 
During the Asian session (European night time), an 
average spread of 3-4 pips is good. Please read this 
manual to learn how to protect against spread widening 
when using the NoNameBot (in "Setting up for trading).
Our recommended broker provides great spreads and 
execution for EURCHF.
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How to download & install 
MetaTrader 4

(Back to Table of Content)

The NoNameBot.com robot requires the “MetaTrader 4” trading platform which is 
freely available here: 

Click Here to Download MetaTrader

If you don't have MetaTrader 4 installed on your computer, I'll now show you how 
to download and install it for free. 

This is the link exclusive for NoNameBot.com owners. Here you can get the 
MetaTrader platform by Think Forex, which features low spreads, low initial 
deposit, transparent and fair No Dealing Desk model, STP (Straight Through 
Processing) of trading orders, excellent execution and the best customer service 
ever.

As a NoNameBot.com customer, you're also entitled to a FREE VPS hosting of 
your robots, for uninterrupted internet connection (conditions apply). 

Note that for the NoNameBot.com to be as profitable as possible, you should 
choose a broker that would not operate a dealing desk that might be working 
against you, and also be sure to use a broker which offers low spreads on the 
EURCHF currency pair. I've found Think Forex to be the perfect broker for this.

To download the Think Forex MetaTrader platform, fill in your details and click 
the button: Open Free Demo Account

After clicking the button, you will be presented with a link to download 
MetaTrader 4, so just click it. 

(continued on next page…)
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A download window similar to the following one should appear:

Simply click the “Run” button to start the installation program.

You are likely to be asked to confirm that you know / trust the source of the file 
and that it is okay to continue – this is perfectly normal and simply part of the 
Windows security system so just agree to any questions asked.

Please be aware that you *might* receive a warning from your Anti-Virus system 
that the mttf4setup.exe file contains a virus – this is not the case at all, so any 
anti-virus warnings should be ignored. 
MetaTrader 4 software contains protection code to prevent hackers from reverse-
engineering the software - this protection code looks very “virus-like” to some 
Anti-Virus systems which are unable to determine the difference. 

As you make your way through the installation process, you will see screens 
looking very similar to the following ones:
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Select your preferred language then click the “Next” button to continue...

When you see the following window, check the agreement box...

(the “Next” button remains inactive until the agreement box is checked)
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Click the “Next” button to continue...

Important: Make a note of the installation folder – you will need to know it later 
to install the NoNameBot.com or any other robot you may wish to test / trade.

Click the “Next” button to continue. You don't have to change anything in the 
following screens, just click "Next" until the button turns to "Finish", which means 
MetaTrader is installed on your computer.
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How to Open a Demo Account

(Back to Table of Content)

When MetaTrader 4 starts up for the first time, you will need to create a “demo” 
account, also called a “practice” account.

1. When you start MetaTrader for the first time, you'll see the following window.

This is the window that enables you to open a free demo account. If you don't 
see this window when you open MetaTrader, choose from the File menu, 
Open An Account:
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2. Fill in all the boxes. 

3. Click the "I agree to subscribe to your newsletters" box, which is mandatory if 
you'd like to proceed with opening the demo account. Then Click "Next".

Normally on this screen you can just click the “Next” button to continue...

You'll be presented with your demo account number and password.

Finally, click the “Finish” button to complete the installation process.
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How to Open a Live

 Real-Money Account

(Back to Table of Content)

If you'd like to open a live real-money Forex account, it is important you open it 
with a reputable broker who offers the best trading conditions. 

The broker I trade with and highly recommend is Think Forex. They offer superior 
execution, highly competitive spreads, robot-friendliness and scalper-enable 
(rare among brokers) and the best customer service. 

Think Forex also provides you with FREE VPS service! 

A VPS is a remote computer continuously connected to the internet. This way 
you can run the NoNameBot continuously without worrying about internet 
connection or leaving your computer open all the time. You can log onto the VPS 
from anywhere, anytime.

This is the link exclusive to NoNameBot.com users:   

Click Here to Open a Live Account 
with   FREE VPS  
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Configuring MetaTrader 4

If you have MetaTrader installed, it is recommended to go to the Options menu 
to check the settings there:

From the Tools menu choose Options.

In the Options window that opens, click the Expert Advisors tab.

You will see the following window. 

Make sure you check all the boxes that are checked in the screen shot below.
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Be sure to UNCHECK the boxes: 

“Disable experts when the account has been changed”
“Disable experts when the profile has been changed”
“Ask manual confirmation” and 
“Confirm DLL function calls”.

Otherwise, the NoNameBot.com might not function correctly afterwards. 

Click the “OK” button to continue.

The next stage is to install NoNameBot.com robot.
 
Before doing so, MetaTrader 4 should be closed down by clicking the large “X” 
button in the top-right of the application window as shown:
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How to Install NoNameBot.com 

(Back to Table of Content  s)  

1. Check that you have the latest version

If you already have MetaTrader installed, than the first step is to ensure that you 
have the latest version. 

To do this, click “Help” in the main MetaTrader 4 menu, then click “About...” and 
a window similar to this:

...will appear showing the version and ‘build’ details plus the date it was released.

Note: The NoNameBot.com robot requires Build 225 or higher.

Under normal circumstances, MetaTrader 4 will automatically check for newer 
builds each time you start the application and will immediately offer you the 
opportunity of updating your version. If you find that an earlier version is installed 
on your computer and you are not being offered the option of updating then 
please call your broker for assistance.

Assuming that everything is working correctly, if you open MetaTrader and you 
don't have the latest build, it will immediately display a window similar to this:
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Whenever you see a screen like this, click the “Start” button and MetaTrader 4 
will update itself to the latest release. The process does not take very long and 
will reduce the possibility of you encountering issues with robots that you may 
wish to use.

Once complete, the following screen appears:

Click the “Update and Restart” button to launch the updated version of 
MetaTrader 4.
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For Windows Vista users only!

You might encounter problems with the automatic update facility of MetaTrader. 

Therefore, if you are asked to update MetaTrader:

1. First close MetaTrader.
2. Right-click on the MetaTrader icon on your desktop.
3. Choose "Run As Administrator".
4. Click "Allow" if asked to allow the running of the update program.

After you completed the purchase process, you received access to the 
NoNameBot.com download page.

1. Right click the link: "Download NoNameBot from here".

2. From the popup menu choose Save Target As…

3. Choose a folder on your computer to download it to. 

For this example, I'll choose the My Documents folder.

4. Navigate to the folder where you saved the NoNameBot.com file
(in this case: C:\My Documents) 
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5. Double-click the NoNameBot_Install.zip file.

Because the file is packed with a compressing program (zip) depending on the 
decompress program installed on your computer, a window will open (which may 
or may not be similar to this) where you'll see the
NoNameBot-Quick_Install.exe program.

6. Double-click the NoNameBot-Quick_Install.exe and the quick setup program 
will be launched:

7. Click the Next button. 
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You'll see the Find Your MetaTrader window:

8. Now you must locate the folder where you installed MetaTrader on your 
computer.

As standard, MetaTrader is installed under the Program Files folder, which is 
usually under the C: hard drive:

C:\Program Files\MetaTrader Folder\

Primary Path Application Folder

Unless you have deliberately chosen a different location, the Primary Path 
(C:\Program Files) will always remain constant. The only variation appears in the 
newer 64-bit (x64) versions of Windows where older, 32-bit applications such as 
MetaTrader 4 are installed into the “C:\Program Files (x32)” folder.

However, the Application Folder varies for every broker providing
MetaTrader 4. But don't worry - if you are not certain where your installation is 
located then there's a simple way to find out: 
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Position your mouse cursor directly over (do not click!) the icon on your Windows 
Desktop that you use to start MetaTrader 4 ...

...and the location will be displayed. As you can see, in this case it is:

“C:\Program Files\MetaTrader Think Forex - 01”

So, after you found out the folder name, return to the "Find Your MetaTrader" 
window and click the Browse… button. 

When the Browse For Folder window appears, double click on the correct folder 
name, in this case C: and then Program Files, and then: MetaTrader Think 
Forex - 01:
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9. When the correct path appears in the top box (as you can see in the above 
screen shot), click OK. 

Now you'll see the path displayed in the window. Make sure it's exactly the path 
you found earlier:

10. Click on the Next button and then on the Install button that appears. 

When the Finish button appears, click it to end the setup program.

Congratulations - your new robot is now installed!

If your MetaTrader is open, close it and then re-open. 

You'll now be asked to input your license code, as explained in the next page:
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Security and Licensing

The Forex NoNameBot.com features an easy quick-install program, and an 
advanced security system. 

Before we go through the installation step-by-step, a few words about the built-in 
security system:

The Forex NoNameBot.com features sophisticated security and licensing that 
protects its code against theft and piracy. For you the user it will not interfere with 
the normal operation of the robot. 

However, please be aware of your license conditions:

1. As with almost any computer software, your license for the robot is valid for 
use on 1 computer only. 

This means that once you install the robot on a computer, this will be the only 
computer you'll be allowed to use the robot on. However, if you need to run 
several MetaTraders, you can do so without limitations, provided all MetaTraders 
are installed on the same computer.

Note: if you've changed computers or would like to install the robot on an 
alternative computer, please contact support: http://nonamebot.com/support.html 
If you would simply like to use the robot on two computers simultaneously, 
please purchase an additional license.

2. If for some reason you applied for a refund of your purchase, your license will 
be automatically revoked and the NoNameBot will automatically stop working on 
your computer. It might not stop immediately, however do not expect the robot to 
operate for more than 1-2 days after your purchase was refunded.

After installation finishes and you open MetaTrader for the first time, the license 
verification screen will appear. This will only happen once, when you start 
MetaTrader after you installed the robot:
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In the license code box, input your ClickBank order number – this serves as your 
license and proof of purchase. 
If you don't know the order number, check your inbox for an email from 
ForexCodeGuard@gmail.com. This email is sent to you immediately upon 
completing your purchase. 

The email from Forex Code Guard looks like this:

An alternative to easily getting your license code is to check your inbox for the 
confirmation email from ClickBank, which will also contain your 
Order Number.
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Input these numbers and letters in the License Code box, then click the Verify 
button. 

The following message will confirm your license:

MetaTrader will now open and you can start using the NoNameBot robot. 
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How to Use the NoNameBot.com

(Back to Table of Content  s)  

After using the installation wizard to install NoNameBot, if your MetaTrader is 
open, close it and then re-open. 
Check the Navigator pane on the left side of the MetaTrader 4 window:

Click the small [+] to the left of “Expert Advisors” to expand that section to display 
the available Expert Advisors (robots):

If everything is correct then the list will contain the NoNameBot robot along with 
any other expert advisors that you have installed or were provided as part of the 
MetaTrader 4 system.

Please note that the NoNameBot icon is gray whilst other icons in the list are 
colored – this is perfectly normal.
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A colored icon means that you have the “source code” for that particular robot i.e. 
the instructions that tell the expert how to trade. A grey icon means that you do 
not – almost all commercial experts will be gray.

(Back to Table of Content  s)  

Important! 
For the NoNameBot to find and exploit all trading opportunities, you must leave 
your MetaTrader open and connected to the internet all the time (except for 
Saturdays and Sundays). Alternatively, use a VPS as explained HERE.

1. To begin trading, open a new chart of the EURCHF currency pair by choosing 
New Chart from the File menu: 

...then click EURCHF (depending on your broker, you may find it in another sub-
menu under the New Chart menu, such as Forex Crosses or a different name). 

2. To change the chart timeframe to 15-minutes (required for NoNameBot to 
operate correctly), in the top toolbar click on the M15 button:
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3. In the navigator window, double-click the NoNameBot:

4. In the NoNameBot window that opens, click the Common tab to see these 
general options. Make sure your screen looks the same, especially the tick in the 
boxes "Allow live trading" and "Allow DLL imports". 

It is very important that all settings match the image above or the expert advisor 
will not function correctly.

Please pay special attention to the “Confirm DLL function calls” option which 
should be unchecked.

5. Click the Inputs tab. You'll see all the different settings, which I'll now guide 
you exactly how to set: 
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Let's start with the Money Management settings:

6. In the Initial_Account box, type the account balance you are starting with. For 
example, if you initially have $500 in your account, type 500:
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7. The Leverage_Factor setting determines the initial trade size that 
NoNameBot will enter the market. If you're not familiar with this concept, you may 
leave it on its default which is 40 or better still, change it to a smaller number 
such as 5 or 10, which will lower the risk.

Always use low leverage!
Remember leverage is a double-edge sword. 

It can increase both losses and profits. 

Example: if your starting account size is 1000 and your set Leverage_Factor to 
10, it will open trades of 10,000 (i.e. 1.0 minilot).

8. Use_Fixed_Lots: if you'd like to set the trade sizes yourself manually, choose 
"true" here, and then input your desired volume (lot size) in the box: Fixed_Lots

9. The next section, "Broker Clock Settings" doesn't need your attention initially, 
because the NoNameBot takes care of these settings automatically. 
When you operate the NoNameBot, it will show the automatically detected GMT 
Shift on the top left side of the chart:

If you believe the detected value (in the example above: 2) is incorrect, or it is 
obviously wrong (for example: -36) you can manually input it by setting AutoGMT 
to false. (Note: on weekends, ignore this value. It will not be correct because the 
market is closed).

Note: In the summer, brokers may shift their server's clock according to summer 
time, so it's always advisable to ask your broker what's the GMT shift and also 
if/when do they change the GMT shift according to summertime.

The reason that a broker's GMT shift is important, is because NoNameBot uses 
the internal MT4 clock to time its entries to the market. Therefore it needs a way 
to know the exact time, even when there is Daylight Savings Time. Each broker 
displays different times, usually according to their respective time zones. 
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10. Making sure your broker don't widen the spread unexpectedly is important, so 
the NoNameBot includes a spread-widening protection, PLUS an alert 
mechanism that will display a large red message on the chart, whenever the 
broker widens the spread. 

In the Spread_Warning setting, you can input the spread in pips, that you'd like 
to be warned if the broker widens. For example, if you input 4 and the spread 
was widened to 5 pips, you'll see a warning in red, at the lower right corner of the 
chart. 

The Max_Spread setting is our unique spread-protection mechanism, that will 
prevent the robot from entering a trade, if the broker widened the spread too 
much. The default is 5, but you can change it to a lower number if your broker 
generally offers a lower spread. Please note that inputting a low spread in 
Max_Spread, such as 2 or 3 pips, will have the effect of enabling less trades to 
open. 

11. Magic_Number is used to set the NoNameBot's trades apart form other 
robot that you might have running, so that it won't interfere with the other robots 
or manual trades. Leave on the default. 

12. Enable Weekly Reports: set to true if you wish to receive to your email, a 
report containing the trades and account stats for the week. The report is sent 
every Friday around the afternoon hours.

Weekly Reports Email:  to get the weekly report, you must input your email 
here.
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Setting up MT4 for Weekly Reports

 In the Terminal window, click the Account History tab.

 Right-click on one of the trade lines, and from the popup menu choose "All 
History".

 Recommended: make sure that the trades are sorted according to open time, 
from earliest to latest. i.e. the line with the "deposit" in it, should be the line 
displayed on top. To sort the list of trades according to open time, click on the 
second column from the left, Time, and make sure it displays a small triangle 
pointing up.

Issues with the weekly email report? 
See the section "Troubleshooting" in this manual.

When you finished setting up the robot's inputs, just click OK to apply the 
NoNameBot.com to the chart. 

©  2010                              www.NoNameBot.com                         Version 1.0
31

http://www.NoNameBot.com/


13. Make sure that at the top right corner of the chart, you see a smiling face like 
this:

If you see a sad face:

You've probably forgotten to tick the "Allow live trading" box in the previous 
steps.

In that case, in the navigator window double-click the NoNameBot again and 
click the Inputs tab.

If you see an x next to the name…

… then press the large elongated toolbar button that says "Expert Advisors":

Important: Do not change the chart timeframe once the robot is attached.
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Important note regarding backtesting:

You should run a backtest only on weekdays 
when the Forex market is open.
 
If you attempt to run a backtest on the weekend 
when the Forex market is closed, MetaTrader 
will skew the results due to the high weekend 
spread.
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Installing and using the

MetaTrader 5 version
(Back to Table of Content  s)  

The NoNameBot is ready for the MetaTrader 5 revolution, and the package 
contains an automated installer for MT5.

You can download the new MetaTrader beta version by clicking HERE.

Note: The NoNameBot MT5 version is considered a beta version, since the MT5 
platform is also in beta stages, and changes may occur in coding and 
functionality. 
The NoNameBot team will immediately email all customers with updates and 
upgrades to NoNameBot as they become available. 
Please note that currently the Weekly Reports feature is not yet implemented in 
the MT5 version.

Installing to MetaTrader 5 (MT5)

Installing the MT5 version is similar to the MT4. Just use the installation wizard: 
NoNameBot_MT5_Install.exe and follow the instructions on screen.
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Once installed, you should open MT5. 

Open a chart of the EURCHF currency pair. To select the M15 timeframe, go to 
the Charts menu, choose Periodicity, then choose 15 Minutes:

If MT5 was already open when you used the installation wizard, then you need to 
do the following in order to see the new robot: in the Terminal window, right click 
Expert Advisors and from the pop up menu choose Refresh.
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Locate the NoNameBot in the Navigator window, double click the robot's name, 
and you'll be presented with the robot inputs window:

In the Common tab, make sure the two boxes on the right are ticked:

To change robot inputs, click the Inputs tab:

The inputs here are identical to the ones on the MT4 version. For further 
instructions on how to use these settings, click HERE.

To finish, click the OK button.
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Make sure that on the top right hand side of the chart, you see a green icon:

If you see a red icon like this…

Then you need to click the AutoTrading button on the top toolbar:

The NoNameBot will now trade the account.

Please note that MetaTrader 5, although generally looking quite similar to MT4, 
features major changes in the way it manages trades. For comprehensive 
guidance on how to use the platform, please refer to the MT5 help, which is 
available when you press the F1 button on your keyboard.
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Troubleshooting
(Back to Table of Content  s)  

Problem: Weekly email report does not arrive to my inbox.

Solution: if you did not get the weekly report to your email by Saturday morning, 
you need to check the following:

 Have you enabled DLL calls, as explained earlier in the section "Configuring 
MetaTrader 4"?

 Have you input the correct email address in the Weekly_Reports_ Email 
box? 

 Did the email get into the Spam folder or Junk email folder of your email? The 
sender is: Juliya Ivanov, NoNameBot.com@gmail.com
Be sure to add the above email address to your "safe list" or "white list".

 Do you have an anti-virus, firewall or other protection software that's blocking 
emails from being sent by applications such as the NoNameBot? 
If all other measures fail, this is the likely cause for you not getting the email, 
and unfortunately it's not in our control. 

Problem: The NoNameBot is running but no trades are being opened.

Solution: It is normal not to have a trade in a certain day. My bot looks for a good 
opportunity to enter the market. If it doesn’t spot a good enough opportunity – it 
wouldn’t jump in. 

Remember, the goal is to trade as profitably as possible, not as often as 
possible!  

Also, don’t forget that the Forex market is closed on Saturday and Sunday. By 
the way, it's not necessary to turn off the NoNameBot during the weekend.

However, if more than 3 days passed with no trade:
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• If you've request a refund, your NoNameBot will stop working 
automatically.

• Verify that you have an icon of a smiley face at the top right corner of the 
chart.

• Make sure you leave MetaTrader open and connected to the internet at all 
times.

• Your account might be disabled for Expert Advisors. Verify with your 
broker that your real account is enabled for Expert Advisors.

• NoNameBot should only be used on the EURCHF M15 chart.

• If everything looks ok, and none of these suggestions solved the issue, 
please contact our support team which will be happy to assist you:
http://nonamebot.com/support.html

Problem: My MetaTrader crashes when I operate the NoNameBot Expert 
Advisor.

Solution: You’re using an old version of MetaTrader. Updating to a new version is 
done automatically: when you open MetaTrader, and connect to any account 
(demo or live) it will open a “Live Update” window. You should allow the live 
update to run.

Problem: I can't find the NoNameBot in MetaTrader 

Solution: The NoNameBot setup program automatically saves the NoNameBot 
files in the correct folders on your computer. 

However, if during the installation process you didn't choose the correct 
MetaTrader folder than you must run the setup program again. 
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Problem: I get a message "DLL not allowed"

Solution:

1. On your keyboard press CTRL+O or use the Tools -> Options menu to 
access the Options window. See screen shot below. 

2. Click the "Expert Advisors" tab.

3. Make sure your Options windows looks exactly the same as this one, with 
several of the boxes are ticked, while others (the inner indented options) are 
NOT ticked:

Problem: I try to run a backtest of the EA and it doesn't work.

Have you downloaded enough historical data? On your keyboard press the F2 
key to access the data download window. 

Another possible problem arises when you forget to "Allow DLLs" in the 
MetaTrader options:

4. On your keyboard press CTRL+O or use the Tools -> Options menu to 
access the Options window. See screen shot below. 
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5. Click the "Expert Advisors" tab.

6. Make sure your Options windows looks exactly the same as this one, with 
several of the boxes are ticked, while others (the inner indented options) are 
NOT ticked:

Note: run backtests only on weekdays. If you attempt to run a backtest on 
the weekend when the Forex market is closed, MetaTrader will skew the 
results due to the high weekend spread.

Problem: What should I do if my computer rebooted or lost power?

Just run MetaTrader again and make sure the NoNameBot is turned on (smiley 
face at top right corner of chart). The NoNameBot will continue trading where it 
left off. 

If you have troubles with having the computer constantly open and connected to 
the internet, there is a low-cost solution using a VPS (Virtual Private Server).
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Problem: Where is the folder of MetaTrader experts? I can’t find it on my 
computer!

As standard, MetaTrader is installed under the Program Files folder, which is 
usually under the C: hard drive:

C:\Program Files\MetaTrader Folder\

Primary Path Application Folder

Unless you have deliberately chosen a different location, the Primary Path

(C:\Program Files) will always remain constant. The only variation appears in 
some 64-bit (x64) versions of Windows where older, 32-bit applications such as 
MetaTrader 4 are installed into the “C:\Program Files (x32)” folder.

However, the Application Folder varies for every broker providing
MetaTrader 4. But don't worry - if you are not certain where your installation is 
located then there's a simple way to find out: 

Position your mouse cursor directly over (do not click!) the icon on your Windows 
Desktop that you use to start MetaTrader 4, and the location will be displayed. 
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Frequently Asked Questions (FAQ)
(Back to Table of Content)

What is a Forex robot (Expert Advisor) ?

An Expert Advisor is computer software that's written in the MQ4 language, 
works in the Metatrader4 trading platform and trades for you automatically!

What is Metatrader4 and where can I download it?

Metatrader4 is a free trading platform. You can download it from your broker's 
website:

Click Here to Download MetaTrader

What broker should I use?

The NoNameBot works on the popular Metatrader 4 platform. You can use any 
broker you like that offers the MetaTrader platform (there are hundreds of them) 

But you'd get a special deal with one of the most reliable brokers in the world, 
Think Forex:

OPEN AN ACCOUNT WITH THINK FOREX NOW:  

Click Here to Open a Live Account

I have MAC OS. Can Metatrader4 work on MAC?

Metatrader4 was originally created for Windows only. If you're a Mac user the 
best solution would be to have it installed on a VPS (Virtual Private Server) 
hosting service.
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Turning the robot on and off

If for any reason you need to turn off the NoNameBot, you can do so by clicking 
the "Expert Advisors" button on the top toolbar:

When this button has a white background, it means that Expert Advisors are 
active and able to open, close or modify trades.

Should I use a demo or real account?

You should operate the Expert Advisor on a demo account only, until you're sure 
that it is compatible with your chosen broker, and you're sure about risking real 
money. And even then, never risk money that you can't afford to lose or don't 
want to lose.

Always remember that leverage is a double-edge sword: it can increase both 
profits and losses. Using excessive leverage might cause you to lose your entire 
account. Use only low leverage to avoid getting into trouble.

What settings should I use?

The NoNameBot.com comes with default settings which are optimal for current 
market conditions.

If you feel confident enough to tweak the default settings, use the NoNameBot's 
Inputs tab as explained in pages 27-32. 

Currency Pairs to Use

The NoNameBot currently works best with EURCHF on the M15 (15-minutes) 
time frame. 

How much money do I need to start trading?
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You can start with relatively small account sizes such as $500 USD. However, 
remember that starting out with low trading capital may put you at disadvantage 
because you will only be able to trade the market in small trade sizes. It's best to 
start with capital of $1,000-5,000 USD or train on a Demo account till you are 
satisfied with the performance.

Important! Never trade with money you can't afford to lose! 
Trading Forex is highly risky – please read the disclaimers in our web site, as 
well as in the first pages of this manual.

Can I have several robots running on the same account?

Yes you can. The NoNameBot uses a unique trade identifier called 
"MagicNumber". This is a unique identifier number attached to each trade the 
NoNameBot opens. The NoNameBot will only manage and close the trades that 
carry this unique identifier. If you have other robots running on the same account 
as the NoNameBot.com, you need to make sure they also use a MagicNumber of 
their own. Otherwise they might interfere with the NoNameBot's trading. The 
NoNameBot itself is smart enough not to interfere with other robots' trades! 

You're advised to also check the other robot's user guide, and to run everything 
on a demo account to monitor the behavior of all robots together.

Can I back test the robot on historical data?

Sure. Backtest also allows you to try different parameters and see what worked 
best in the past. Past results are not indicative of future results (see disclaimer).

Be sure to run the backtest on one of the weekdays, and avoid backtesting on 
weekends (because the results on weekends are incorrect).

When you're backtesting using the Strategy Tester built inside MetaTrader 
(View -> Strategy Tester) make sure you do the following:

1. Choose from the Tools menu -> Options, click the Expert Advisors tab and 
make sure Allow DLL imports is ticked. Generally, your Options should look 
like this:
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2. To open the MetaTrader Strategy Tester, choose from the View menu -> 
Strategy Tester. You'll see this window:

3. Choose the NoNameBot expert advisor, the EURCHF symbol and M15 
period. You can also specify the dates to check.

4. Click the Expert properties button, and click the Inputs tab:
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5. For the AutoGMT input choose false, then in the Broker_GMT_Manual box 
input your broker's GMT shift. If you don’t know what is it, please contact your 
broker and ask the question: "what is your GMT shift?".

6. Click OK to close this window, and click the Start button to start the backtest.

How do I optimize the settings?
 
If you're an advanced user, you can use optimization to search for different 
parameters than the default ones. The NoNameBot enables optimization of its 
parameters using the "Strategy Tester" window. 

See MetaTrader's help for further details. 

Does my computer need to be working all the time? 

Yes. For the NoNameBot's correct operation the following three conditions must 
be met:

1. Your computer is constantly on.
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2. MetaTrader software is always working. 

3. You have a constant connection to the Internet. 

For example, when you have an open trade the Expert Advisor needs to 
constantly manage it (modify stop loss levels, close a trade, etc.).

If you're not able to maintain constant connection to the internet, you should use 
a VPS (Virtual Private Server) service. 

Do I need to watch the NoNameBot when it is working?

No, the robot frees you from the need to be glued to your screen 24/7 to look for 
trading opportunities. Everything is done automatically for you! 
You just need to be sure that MetaTrader stays open all the time and connected 
to the internet. 

What should I do if my computer rebooted or lost power?

Just run MetaTrader again and make sure the NoNameBot.com is turned on (as 
explained in page 31). The NoNameBot will continue trading where it left off.
 
If you have troubles with having the computer constantly open and connected to 
the internet, there is a low-cost solution using a VPS (Virtual Private Server).

The files are in zip format. Where can I get WinZip or other programs to 
unzip files?

You can use the free WindowsXP/Vista zip service. You can also use free 
WinRAR to unzip files: http://www.rarlab.com/

That's all - I wish you Good Luck with your trading!

Juliya Ivanov
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